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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between Windstream (MetaSwitch platform) and Avaya IP Office R9.0.1.

Windstream SIP Trunking Service provides PSTN access via a SIP trunk between an
enterprise site and the Windstream network as an alternative to legacy analog or digital trunks.
This approach generally results in lower cost for the business customer.

Windstream is a member of the Avaya DevConnect Service Provider program. Information in
these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between Windstream (MetaSwitch platform) and Avaya IP Office R9.0.1.

In the sample configuration, the Avaya IP Office solution consists of Avaya IP Office 500V2
running Release 9.0 SP1 software, Avaya Preferred Edition (a.k.a VVoicemail Pro) messaging
application, Avaya H.323 and SIP hard phones, and SIP-based Avaya softphones.

The Windstream SIP Trunking Service provides PSTN access via a SIP trunk between an enterprise
site and the Windstream network as an alternative to legacy analog or digital trunks. This approach
generally results in lower cost for the business customer.

2. General Test Approach and Test Results

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

The general test approach was to configure a simulated enterprise site using Avaya IP Office to
connect to the Windstream SIP Trunking Service via the public Internet. The configuration shown in
Figure 1 was used to exercise the features and functionality tests listed in Section 2.1

2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered during
the compliance test.

e SIP OPTIONS queries to and responses from the service provider.

e Incoming calls from the PSTN to H.323 and SIP telephones at the enterprise. All inbound
PSTN calls were routed to the enterprise across the SIP trunk from the service provider.

e Outgoing calls to the PSTN from H.323 and SIP telephones at the enterprise. All outbound
PSTN calls were routed from the enterprise across the SIP trunk to the service provider.

e Various call types including: local, long distance, outbound toll-free, international, and

operator-assisted calls (0 + 10-digits).

G.711u and G.729a codecs.

Caller ID presentation and Caller ID restriction.

DTMF transmission using RFC 2833.

Voicemail access and navigation for inbound and outbound calls.

Telephony supplementary features such as hold and resume, transfer, and conference.

Off-net call forwarding and call transfer/conference.

Twinning on inbound calls to PSTN mobile phones.

Use of SIP INVITE or SIP REFER messages for call redirection to the PSTN.
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Inbound and outbound long-duration call stability.

Inbound and outbound long hold time call stability.

Response to incomplete call attempts and trunk busy or error conditions.
G.711 pass-through fax.

Items not supported or not tested include the following:

Inbound toll-free and emergency calls (911) were not tested as part of the compliance test.
The compliance test circuit did not support Operator call (0) and Directory Assistance (411)
calls, but Windstream indicated that both types of calls are supported in the production
network.

Windstream SIP Trunking does not fully support T.38 faxing and prefers G.711 pass-through
fax which was tested and verified during the compliance test.

2.2. Test Results

Interoperability compliance testing of Windstream SIP Trunking was completed with successful
results for all test cases with the exception of the observations/limitations described below.

Response to OPTIONS — Windstream responded to OPTIONS from IP Office with "403
From: URI not recognized"”. The MetaSwitch platform used by Windstream expects a DID
number in the FROM header of the OPTIONS message while IP Office cannot be
configured to do so. However, IP Office treats any response messages returned as a
legitimate indication that the far end is active and communicating, therefore will not take the
SIP trunk out of service. This 403 response, instead of "200 OK", had no impact on the
status of the SIP trunk between Windstream and the enterprise site.

Codec Lockdown — For outbound calls with G.729a as the preferred codec offered in the
SDP of outbound INVITE (either a single G.729a codec or G.729a followed by other
codecs), the call connect "200 OK" from Windstream would contain the same set of codecs
(G.729a & G.711u) in the SDP instead of just the preferred G.729a codec (first in the list). If
IP Office was configured to offer G.711u as the preferred codec, the call connect "200 OK"
from Windstream would contain only G.711u in the SDP as expected.

Use of REFER for Call Transfer — Windstream prefers use of INVITE for off-net call
transfer which was successfully verified in the compliance test. Use of REFER for off-net
call transfer was also tested. Though call transfer using REFER succeeded with expected
user experience, the signaling was not completely clean: the post-REFER NOTIFY
messages from Windstream contained no message body for notification contents, causing IP
Office to reject these NOTIFY messages.

Blocking CPN for Outbound Calls — If IP Office was configured to block Calling Party
Number (CPN), the outbound INVITE would receive a "403 Forbidden" response from
Windstream, failing the call. This is because Windstream does not support "anonymous"
user in the INVITE's From header. As a workaround, the IP Office user could dial "*67" as a
prefix to the PSTN destination number to let Windstream/PSTN block the CPN.

Session Refresh — Windstream did not initiate session refresh via SIP re-INVITE or
UPDATE messages, and no message headers for session refresh handshake were contained
in SIP messages from Windstream. In the compliance test, session refresh for active calls
was initiated from IP Office.
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e Direct Media — Avaya IP Office R9.0 offers a new Direct Media capability on IP Office
500V2 that allows IP endpoints to send RTP media directly to each other rather than having
all the media flow through the IP Office, using up VolIP and relay resources. This capability
is not supported on the configuration described in these application notes where Avaya IP
Office connects to the service provider network via a direct public Internet connection
without using an enterprise Session Border Controller.

2.3. Support
Contact information for technical support on the Windstream SIP Trunking service:

e \Web: http://www.windstreambusiness.com/customer/support
e Telephone: (866) 445-5882

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAY A (866-462-8292)
provides access to overall sales and service support menus.

3. Reference Configuration

Figure 1 illustrates the test configuration showing an enterprise site connected to Windstream SIP
Trunking.

Located at the enterprise site is an Avaya IP Office 5002 running the Release 9.0 SP1 software.
Endpoints include various Avaya IP Telephones (with H.323 and SIP firmware) and SIP-based
Avaya softphones (Avaya IP Office Video Softphone and Avaya Flare® Experience for Windows).
The site also has a Windows PC running Avaya Preferred Edition (a.k.a. Voicemail Pro) for
providing voice messaging service to the Avaya IP Office users, and Avaya IP Office Manager for
administering the Avaya IP Office.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user
phones will also ring and can be answered at the configured mobile phones.
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Figure 1: Test Configuration

For security purposes, any actual public IP addresses used in the compliance test were changed to
192.168.x.x throughout these Application Notes.
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During compliance testing, Avaya IP Office users dialed a short code of 8 or 9, plus N digits to send
digits across the SIP trunk to Windstream. The short code (8 or 9) was stripped off by Avaya IP
Office but the remaining N digits were sent to the service provider network. For calls within the
North American Numbering Plan (NANP), the user dialed 11 (1 + 10) digits for long distance calls
and 10 digits (without the leading 1) for local calls. Thus, for these NANP calls, Avaya IP Office
sent 10 or 11 digits in the Request URI and the To header of an outbound SIP INVITE message.
Windstream sent 10 digits in the Request URI and the To header of inbound SIP INVITE messages.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and Avaya IP Office such as a Session Border Controller
or data firewall. A complete discussion of the configuration of these devices is beyond the scope of
these Application Notes. However, it should be noted that SIP and RTP traffic between the service
provider and Avaya IP Office must be allowed to pass through these devices.

The administration of the Avaya Preferred Edition (Voicemail Pro) messaging service and endpoints
on Avaya IP Office are standard. Since these configuration tasks are not directly related to the inter-
operation with the Windstream SIP Trunking Service, they are not included in these Application
Notes.

4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment / Software Release / Version
Avaya IP Office 500V2 9.0.100.845
Avaya IP Office COMBO6210/ATM4 Module 9.0.100.845
Avaya IP Office Manager 9.0.100.845
Avaya Preferred Edition (a.k.a Voicemail Pro) 9.0.1.0.53
Avaya 1616 IP Telephones (H.323) Avaya one-X Deskphone 1.3 SP4
Avaya 9611G IP Telephones (H.323) Avaya one-X Deskphone

6.3.0.37_V452
Avaya 9630G IP Telephones (H.323) Avaya one-X Deskphone 3.2.1.2A
Avaya 1120E IP Telephone (SIP) 4.03.18.00
Avaya 1140E IP Telephone (SIP) 4.03.18.00
Avaya IP Office Video Softphone (Windows) 3.2.3.49 68975
Avaya Flare® Experience for Windows 1.1.4.23
Windstream Components

Equipment / Software Release / Version
MetaSwitch 8.1.0 Patch B
Edgewater Networks
EdgeMarc 4570 Session Border Controller Version 11-6-13

Testing was performed with IP Office 500V2, but this testing also applies to IP Office Server
Edition running the same version of software. Note that IP Office Server Edition requires an
Expansion IP Office 500V2 to support analog or digital endpoints or trunks.
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5. Configure Avaya IP Office

Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the PC
running Avaya IP Office Manager, select Start - Programs - IP Office - Manager to launch
the application. A screen that includes the following in the center may be displayed:

WELCOME to IP Office Administration

What would you like to do ?

Create an Offline Configuration

DOpen Configuration from System

Fead a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the configuration
may be alternatively opened by navigating to File = Open Configuration at the top of the Avaya
IP Office Manager window. Select the proper Avaya IP Office system from the pop-up window and
log in with the appropriate credentials.

The appearance of the IP Office Manager can be customized using the View menu. In the screens
presented in this document, the View menu was configured to show the Navigation Pane on the left
side, omit the Group Pane in the center, and show the Details Pane on the right side. Since the Group
Pane has been omitted, its content is shown as submenus in the Navigation Pane. These panes
(Navigation and Details) will be referenced throughout the Avaya IP Office configuration. All
licensing and feature configuration that is not directly related to the interface with the service
provider (such as twinning and IP Office Softphone support) is assumed to already be in place.

In the sample configuration, Jersey City was used as the system name. All navigation described in
the following sections (e.g., License = SIP Trunk Channels) appears as submenus underneath the
system name Jersey City in the Navigation Pane. The configuration screens highlight
values/settings configured for the compliance test. Defaults were used for other values and may be
customized based upon requirements in the field.
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5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require Avaya IP Office to be
licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, contact an
authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in the
Navigation Pane. Confirm a valid license with sufficient Instances (trunk channels) in the Details

Pane. The screen below also shows the valid license for Avaya IP endpoints.

i Avaya IP Office Manager Jersey City [9.0.100.845] [Administrator{Administrator)]

File Edit View Tools Help

IP Offices

@& BOOTP (2)

Operator (3)

{4 Line (6)
-+ Control Unit {2)
()

@@ User (18)
[ 5§ Group (1)
(#-@% sShort Code (66)
B service (0)
s RAS (1)
) @ Incoming Call Route (21)
8 WanPort (0)
om Directory (0)
£ Time Profile (0)
) @ Firewall Profile (1)
[l P Route (4)
@y Account Code (0)
%
W& Tunnel {(0)
|- §3 User Rights (8)
¢ ARS (2)
@ RAS Location Request {0)
8 Location (0)

=

License | Remote Server
License Mode  License Mormal

PLDS Host ID 111311587034
Feature License Key Instances Status o) Add
| Report Viewer ‘ 255 Yalid
| Mobility Features o 255 Obsolete Remove
| IPSO0 Yoice Networking Channels - 255 valid
| IPS00 Yoice Metworking Channels - 4 valid
YCM Channel Migration - 255 Valid
|5IP Trunk Channels 255 Valid]
IPS00 Universal PRI {Additional chan... 255 Valid
| RAS LRQ Support (Rapid Response) - 255 Valid
| IP Office Dealer Support - Standard E... - 255 Valid
| IP Office Dealer Support - Profession... 255 valid
| 1P Office Distributor Support - Standa... 255 Valid
| IP Office Distributor Support - Profes... 255 Valid
| UMS Web Services 255 Yalid
| CCRSUP 255 valid
| Customer Service Agent 255 valid
| CCR Designer 255 Valid
| CCR CCCUPG 255 valid
| 1600 Series Phones 255 Yalid
| Third Party APT = 255 Valid
one-% Portal for IP Office 255 Valid
| Avaya IP endpoints 255 Valid |
| Customer Service Supervisor 255 valid B
| Essential Edition Additional Voicemail ... 255 Yalid
| Teleworker 255 Valid
| Mobile Worker 255 Yalid
| Power User 255 valid
| Advanced Edition 255 Valid v
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To view the physical hardware comprising the Avaya IP Office system, expand the components
under the Control Unit in the Navigation Pane. In the sample configuration, the second component
listed is a Combination Card. This module has 6 digital station ports, two analog extension ports, 4
analog trunk ports and 10 VCM channels. The VCM is a VVoice Compression Module supporting
VoIP codecs. An Avaya IP Office hardware configuration with a VCM component is necessary to

support SIP trunking

To view the details of the component, select the component in the Navigation Pane.

The screen below shows the details of the IP 500 V2:

IP Offices

- R BOOTP (2)
[#4/ Operator (3)
) Jersey City
# %39 System (1)
#-F4 Line (6)
= Control Unit {2)
-
= 2 COMBOG210{ATM4
[#-4 Extension (17)
@ User(18)
3¢ Group (1)
[+ @% Short Code (66)
B service (0)
ol RAS (1)
3 e Incoming Call Route (21)
£8 wanPort (0)
o Directory (0)
£ Time Profile (0)
@ @ Firewall Profile (1)
& IP Route {4)
&g Account Code (0)

B IP 500 V2 =

| Unit

Device Number 1 \

Unit Type 1P 500 Y2

Version 9.0,100.845

Serial Number

Unit IP Address [10.32.128.30

Interconnect Mumber

|

[

— ]

|

C |
|

Module Number :Control Unit

. License (64)

The screen below shows the details of the Combination Card:

IP Offices

®- & BOOTP(2)
Operator (3)
= ) Jersey City
[#-#39 System (1)
#F4 Line ()
= Control Unit {2)
= 11PS00 V2
-
[+ 4 Extension (17)
@ User(18)
3¢ Group (1)
(- @% Short Code (66)
B service (0)
o RAS (1)
#- € Incoming Call Route (21)
£9 wanPort (0)
a4 Directory (0)
£ Time Profile (0)
& @ Firewall Profile (1)
- il IP Route (4)
& Account Code (0)

g

E COMBO6210/ATM4 £

| X | v|<]|

Unit
Device Number 2

Unit Type [coMBOBZ10{ATM4.

Version 9.0,100.845

Serial Number
Unit IP Address

Interconnect Number

Module Number féontroi Unit 1

W, License (64)
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5.2. System

This section configures the necessary system settings

5.2.1. System - LAN2 Tab

In the sample configuration, Jersey City was used as the system name and the WAN port (LAN2
port) was used to connect the Avaya IP Office to the public network. The LAN2 settings correspond
to the WAN interface on Avaya IP Office. To access the LAN2 settings, first navigate to System -
Jersey City in the Navigation Pane and then navigate to the LAN2-> LAN Settings tab in the
Details Pane. Set the IP Address field to the IP address assigned to the Avaya IP Office WAN port.

Set the IP Mask field to the mask used on the public network.

Ei

System | LANL | LANZ |DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | ¥CM | CCR | Codecs

IP Offices

=)-#%9 System (1)
2 Jersey City
#-FH Line (6)
{#“=» Control Unit (2)
#-4 Extension (16)
#-§  User(18)
+-5¢ Group (1)
(# 8% Short Code (65)
B service (0)
o RAS (1)
- Incoming Call Route (19)
8 wanPort (0)
o Directory (0)
£ Time Profile {0)
@ Firewall Profile (1)
] 1P Route {(4)
@m Account Code (0)
., License (64)
W& Tunnel {0}
#-fq User Rights (8)
- ARS (2)
" RAS Location Request (0)
5 Location (0)

[ LAN Settings | yoIP || Network Topology

Jersey City™

IP Address |192 . 168 . 96 . 231 |
IP Mask 255 . 255 . 255 128
Primary Trans. IP Address | 0 0 0 0 |
Firewall Profile ‘7<7Non¢7>
RIP Mode None

[] Enable MaT

~

Number OF DHCP IP Addresses 200 &
DHCP Mode
O server O Client O Dialin  (®) Disabled

| v |

Advanced
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On the VoIP tab of LANZ in the Details Pane, configure the following parameters:

e Check the SIP Trunks Enable box to enable the configuration of SIP trunks.

e Inthe RTP section, the RTP Port Number Range can be customized to a specific range of
receiving ports for the RTP media. Based on this setting, Avaya IP Office would request RTP
media be sent to a port in the configurable range for calls using LAN2,

e Inthe Keepalives section, select RTP for Scope; select Enabled for Initial keepalives; enter
30 for Periodic timeout. These settings direct IP Office to send a RTP keepalive packet
starting at the time of initial connection and every 30 seconds thereafter if no other RTP
traffic is present. This facilitates the flow of media in cases where each end of the connection
is waiting for media from the other, as well as helping to keep firewall ports open for the
duration of the call.

= Jersey City e | X |« | < |
System | LAN1 | LANZ |DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | ¥CM | CCR | Codecs
LAN Settings VoIP %Network Topology | 7
[ ~
H323 Gatekeeper Enable
[] Auto-create Extn Auto-create User [] H323 Remote Extn Enable
I SIP Trunks Enable I
SIP Registrar Enable
[[] auto-create ExtnfUser [] s1P Remote Extn Enable
Domain Name \
LUDP UDP Port 5060 2| RemoteUDPPort |20
Layer 4 Protocol TCP TCP Port ;5060 = ; Remote TCP Port ‘
O s TLSPort (5061 3| RemoteTLSPort [506!
Challenge Expiry Time {secs) |10 >
RTP
Port Number Range
Minimurm ?749152 v Maximurm 53246 3\
Port Number Range (NAT)
Minimurn 349152 < Maxirmum 53246 % |
Enable RTCP Monitoring on Port 5005
Keepalives
Scope %RTP V; Periodic timeout ;730
Initial keepalives iénabled v J}
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Scroll down to the DiffServ Settings section. Avaya IP Office can be configured to mark the
Differentiated Services Code Point (DSCP) in the IP Header with specific values to support Quality
of Services policies for both signaling and media. The DSCP field is the value used for media and
the SIG DSCP is the value used for signaling. The specific values used for the compliance test are
shown in the screen below and are also the default values. For a customer installation, if the default
values are not sufficient, appropriate values should be provided by the customer.

= Jersey City £ | X | v | < |
| System | LANL ‘ Lan2 |DNS | Voicemail | Telephony | Directory Services | System Events;‘“SMTP | SMDR | Twinning | ¥CM | CCR | Codecs |
LAN Settings | YOIP | Network Topology .
‘ Enable RTCP Monitoring on Port S005 Al
Keepalives
Scope ;RTP 1 vi Periodic timeout \30
Initial keepalives fAEnabIed v :
| | DiffServ Settings
(1l 4 : s : \ 5 =
B8 |$ \ DSCP(Hex) B8 & | video DSCP{Hex) [FC < \ DSCP Mask {(Hex) }88 % | SIGDSCP (Hex)
46 2| psce 46 3| videoDscP 63 2| pscpmask 3 3| siepsce
DHCP Settings
Primary Site Specific Option Number (SSOM) 176 5 ‘
Secondary Site Specific Option Mumber (SSON) 242 (.:’
VLAN Mok Present v “
1100 Voice YLAN Site Specific Option Number (SSON) 232 31
1100 Voice YLAN IDs
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On the Network Topology tab of LAN2 in the Details Pane, configure the following parameters:

e Select Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With the
Open Internet setting, STUN Server Address is not used.

e Set Binding Refresh Time (seconds) to a desired value. This value is used as one input to
determine the frequency at which Avaya IP Office will send SIP OPTIONS messages to the
service provider. See Section 5.9 for complete details.

e Set Public IP Address to the IP address of the Avaya IP Office WAN port.

e Set Public Port to 5060 for UDP.

=Y Jersey City” - | X[ v]|<|

| System | LaNL | LANZ |DNS || Yoicemai | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | ¥CM | CCR | Codecs
LAN Settings | voIP | Network Topology |
Metwork Topology Discovery

STUN Server Address [ : STUNPort 3478 -]
Firewall/NAT Type Ebpen Internet ¥
Binding Refresh Time (seconds) ?'377 3
Public IP Address (192 168 . 9 . 231 | Cancel
Public Port
LDP 5060 :
TCP o El
TLS 0 *

[] run STUN on startup

During compliance testing, the LANL interface was used to connect the Avaya IP Office to the
enterprise site IP network. The LANL1 interface configuration is not directly relevant to the interface
with Windstream, and therefore is not described in these Application Notes.
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5.2.2. System - Voicemail Tab

In the VVoicemail tab of the Details Pane, configure the SIP Settings section. The SIP Name and
Contact are set to one of the DID numbers assigned by Windstream. The SIP Display Name (Alias)
parameter can optionally be configured with a descriptive name. Uncheck the Anonymous box to allow
the VVoicemail Caller 1D information to be sent to the network.

Note the selection for Voicemail Type and the IP address setting for Voicemail IP Address. These
are for configuring VVoicemail Pro as the voice messaging service for Avaya IP Office users (part of
the standard IP Office setup beyond the scope of these Application Notes).

=

= Jersey City e | X | v | = |

| System | LAN1 | LANZ | DNS Yoicemail Telephony | Directory Services | System Events | SMTP | SMDR || Twinning | YCM CCR Codecs

Voicemail Type Yoicemail Lite/Pro : [[] Messages Button Goes To Yisual Voice

Voicemail Destination

Voicemail IP Address 10 32 128 7% |
Backup Voicemail IP Address | 0 0 0 0
Yoicemail Channel Reservation

Unreserved Channels |237

Auto-Attendant 2 S| voice Recording i5 &l Mandatory Voice Recording 5 = ‘
[ | [ |

Announcements 5 % | Maibox Access  |S vl|

DTMF Breakout

Reception [ Breakout (DTMF 0) 1 v ‘

Breakout (DTMF 2) \ v

Breakout (DTMF 3) \ v|

SIP Settings

SIP Name 5012871491

SIP Display Name (Alias) ;'v'oicemail }

Contact 5012871491 1

Anonymous |:|

Call Recording

4

Auto Restart Paused Recording (secs) 115

Hide Auto Recording |
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5.2.3. System - Telephony Tab

Navigate to the Telephony = Telephony tab on the Details Pane. Enter or select 0 for Hold
Timeout (secs) so that calls on hold will not time out. Choose the Companding Law typical for the
enterprise site. For the compliance test, U-LAW was used. Uncheck the Inhibit Off-Switch
Forward/Transfer box to allow call forwarding and call transfer to the PSTN via the service
provider across the SIP trunk per customer business policies. Note that this configuration might pose
a security issue (Toll Fraud). Customers should exercise caution with this configuration.

P
-
-

| System | LAN1 | LAMZ | DMS

Jersey City

I | >

| v | < |

Voicemail} Telephony | Directory Services | System Events | SMTP | SMDR. | Twinning | YCM CCR Codecs

‘ Telephony ‘Park&Page Tones & Music | Ring Tones | SM Call Log || TUL
-~ |
Analogue Extensions Companding Law —,
| Switch Line
Default Outside Call Sequence | Mormal v
Default Inside Call Sequence ;ﬁing Type 1 - | ® U-Law ® U-Law Line
Default Ring Back Sequence 3ﬁing Type 2 v
7 5 O A-Law O A-Law Line
Restrict Analogue Extension Ringer Yoltage O
|
| Dial Delay Time {secs) 4 = [] pss status
‘ Dial Delay Count 0 - } Auto Hold
Default No Answer Time (secs) 115 = ‘ Dial By Haime
¥| sh
\ IHoId Timeout (secs) 0 ~ H Show Account Code
| 5 2
B @l Inhibit OFf-Switch Forward{Transfer
Park Timeout (secs) 300 i | 0 / I
] E] Restrict Network Interconnect
Ring Delay (secs) S =]
e — [T] orop External Only Impromptu Conference
Call Priority Promotion Time (secs) |Disabled &
= — [] visually Differentiate External Call
Default Currency |UsD ¥
= ——— [ unsupervised Analog Trunk Disconnect Handling
Default Name Priority | Favor Trunk v
‘ High Quality Conferencing
Media Connection Preservation | Disabled v
— D Strict SIPS
Digital/Analogue Auto Create User R
L — |
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5.2.4. System - Twinning Tab

To view or change the System Twinning settings, navigate to the Twinning tab in the Details Pane
as shown in the following screen. The Send original calling party information for Mobile

Twinning box is not checked in the sample configuration, and the Calling party information for
Mobile Twinning is left blank.

-

= Jersey City (] |t [ sl

| System | L&AN1 | LANZ | DNS | Yoicemail | Telephony | Directory Services | System Events | SMTP | SMDR ‘ Twinning |YCM | CCR | Codecs

[] send original calling party information For Mobile Twinning

Calling party information for |
Mobile Twinning L

5.2.5. System — Codecs Tab

In the Codecs tab of the Details Pane, select or enter 101 for RFC2833 Default Payload. This setting
was recommended by Windstream for use with out-band DTMF tone transmissions.

Ko
-

= Jersey City £ || |
| System | LAN1 | LANZ | DNS Voicemail | Telephony || Directory Services | System Event§ | SMTP | SMDR | Twinning | YCM CCR ‘ Codecs |
RFC2833 Default Payload {101 ]

Available Codecs Default Codec Selection

: Unused Selected

G711 ULAW 64K == G.711 ULAW 64K

G.711 ALAW 64K G.711(AI).AW 64K

G.729(a) 8K CS-ACELP

D G.722 64K G.723.1 6K3 MP-MLQ

G.729(a) 8K C5-ACELP 7%

G.723.1 6K3 MP-MLQ

=5
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5.3. IP Route

Navigate to IP Route - 0.0.0.0 in the left Navigation Pane if a default route already exists.
Otherwise, to create the default route, right-click on IP Route and select New (not shown). Create
and verify a default route with the following parameters:

e Set IP Address and IP Mask to 0.0.0.0.
e Set Gateway IP Address to the IP address of the gateway for the public internet network.
e Set Destination to LAN2 from the drop-down list.

IP Offices

# R BOOTP(2)
[#-¢7 Operator {(3)
=-%% Jersey City
[# %29 System (1)
#-FH Line (6)
{# = Control Unit (2)
[+ -4 Extension (16)
@ User(18)
#-5f Group (1)
(# 8% Short Code (65)
B service (0)
®-o; RAS (1)
® g Incoming Call Route (19)
8 wanPort (0)
o Directory (0)

£ Time Profile (0)
- @ Firewall Profile (1)
=] IP Route (4}
Kl 0.0.0.0
Bl 10.32.0.0
Bl 152.168.0.0
Bl 192.168.99.0

@ Account Code (0)

Ei
| 1P Route |

1P Address

1P Mask

0.0.00"

Gateway IP Address | 192 . 168

Destination

Metric

k@ X[ v |

| >

D Proxy ARP

<3|
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5.4. Administer SIP Line

A SIP Line is needed to establish the SIP connection between Avaya IP Office and the Windstream
SIP Trunking Service. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by IP Office
Manager to create a SIP Line. Follow the steps in Section 5.4.1 to create the SIP Line from the
template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

IP addresses

SIP Credentials (if applicable)

SIP URI entries

Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Sections 5.4.2 through 5.4.6.

Also, the following SIP Line settings are not supported on Avaya IP Office Basic Edition:

e SIP Line — Originator number for forwarded and twinning calls
e Transport — Second Explicit DNS Server
e SIP Credentials — Registration Required

5.4.1. Create SIP Line From Template

1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to US_ Windstream_SIPTrunk.xml. The file name is important in locating the
proper template file in Step 5.

2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File = Preferences. In the IP Office Manager Preferences window that appears,
select the Visual Preferences tab. Verify that the option box is checked next to Enable
Template Options. Click OK.

4l 1P Office Manager Preferences @@
Preferences | Directories | Discovery | Visual Preferences | securiby || validation

Icon Size | Small w
Multiline Tabs
Enable Template Options

) [ o [ coea |[ o |
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3. Import the template into IP Office Manager. From IP Office Manager, select Tools =
Import Templates in Manager. This action will copy the template file into the IP Office
template directory and make the template available in the IP Office Manager pull-down
menus in Step 5. The default template location is C:\Program Files\Avaya\lP
Office\Manager\Templates.

"} Avaya IP Office Manager Jersey City [9.0.100.845] [Administrator)

File  Edit Yiew TooIs‘I Help

3 A | _§| Extension Renumber...

Line Renumber...
IP Offie

% Connect To...
&= BOOTP (2)
#-¢7 Operator (3) B ¥ :
(== Jersey City SCN Service User Management | Yoicemail
=)-#39 System (1) . T e
= Jersey Busy on Held Yalidation
BT Linei(6) MSN Configuration 10
[+ <= Control Unit
[+ -4 Extension (1 : B3z Vess ( i
® & User(18) I Import Templates in Manager |!:rvation
g Group (1) i
[+ §% Short Code (66) Unreserved Channels (237 |
@B service (0) —
& ol RAS(1) Auto-Attendant 2 | void
€@ Incoming Call Route (21) o E__® wal

In the pop-up window (not shown) that appears, select the directory where the template file
was copied in Step 1. After the import is complete, a final import status pop-up window (not
shown) will appear stating success or failure. Click OK (not shown) to continue.

If preferred, this step may be skipped if the template file is copied directly to the IP Office
template directory.
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4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New - New SIP Trunk From Template.

IP Offices SIP Line -Line 17

# R BOOTP(2) | SIP Line [Transport | SIP LRI VoIP | 138 Fax| SIP Credentials
[#-¢% Operator (3) } = N ) ) ;
" ;) i ers::l "] Mew > H323 Line
@ T4 L <9 Generate SIP Trunk Template 1P DECT Line
<= Co SIP Line
[+ 4 Ex x Cut Chrl+¥% )
5 a us{ = SM Line g
=3 Copy Ctrl+C ‘
g Gr ) . SIP DECT Line :
@ 9% Sh R 5 I Mew SIP Trunk From Template JJ
@B 5ef X | Delete Ctrl+Del
B ollg RA + Validate ’» ‘
# P Ing ‘ .
£ ws Rnec ' \ \
s Dir Mew from Template (Binar
€7 Tin R ) Y) \pivgrsjon Header v ‘
% @ Fi Export as Template (Binary) :
= 1t RSSO TP TETTToT [BV Source IP address bl
[+ IP Route {(4) el
& Account Code (0)
. License (64)

5. In the subsequent Template Type Selection pop-up window, select United States from the
Country drop-down list and select Windstream from the Service Provider drop-down list as
shown below. These values correspond to parts of the file name
(US_Windstream_SIPTrunk.xml) created in Step 1. Click Create new SIP Trunk to
finish creating the trunk.

Ve Template Type Selection

Locale
Country United States v ‘
Service Provider ' v | [] Display &l

[ Create new SIP Trunk ] [ Cancel ]

Note that the newly created SIP Line may not immediately appear in the Navigation pane
until the configuration was saved, closed and reopened in IP Office Manager.

6. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration
shown in Sections 5.4.2 through 5.4.6.

AMC; Reviewed: Solution & Interoperability Test Lab Application Notes 20 of 38
SPOC 6/17/2014 ©2014 Avaya Inc. All Rights Reserved. WS-SipTrkIPO9



5.4.2. SIP Line - SIP Line Tab
In the SIP Line tab of the Details Pane, configure the parameters as shown below:

e SetITSP Do

main Name to the IP address of the service provider SIP Trunking access

interface provided by Windstream (192.168.64.174).

e ChecktheIn
e Check OOS

Service box.
box. Avaya IP Office will check the SIP OPTIONS response from the far end to

determine whether to take the SIP Line out of service.

e Set Call Routing Method to Request URI. Avaya IP Office will route inbound calls based
on the number in the Request URI.

e Set Send Caller ID to P Asserted ID. With this setting and the related configuration in
Section 5.2.4, Avaya IP Office will include the PAI (P-Asserted-Identity) Header for calls
that are forwarded or redirected via Mobile Twinning out the SIP Line to the PSTN.

e Uncheck RE

FER Support. Windstream SIP Trunking prefers to use the INVITE instead of

REFER message for off-net call re-direction as in call transfer.

e Set Method for Session Refresh to Auto. With this setting Avaya IP Office will send
UPDATE messages for session refresh if the other party supports UPDATE. If UPDATE is
not supported, re-INVITE messages are sent.

e Set Session Timer (seconds) to a desired value. With the value as shown below, Avaya IP
Office will send session refresh UPDATE or re-INVITE to the service provider every 5
minutes (half of the specified value)

IP Offices

#- K BOOTP (2)
#-4¢# Operator (3)
(=% Jersey City
+-%%9 System (1)
=7 Line (6)
1
12
133
14
.
", 13
#-<= Control Unit {2)
+ -4 Extension (17)
+ & User (18)
+ 5§ Group (1)
+ 8% Short Code (66)
@ Service (0)
ol RAS (1)
P Incoming Call Route (15)
€3 wanPort (0}
s Directory (0)
£ Time Profile (0)
@@ Firewal Profile (1)
+ [l IP Route (4)
@ Account Code (0)
. License (64)
W& Tunnel {(0)
# §q User Rights (8)
# ¢ ARS (2)
« RAS Location Request (0)
5 Location (0)

B SIP Line - Line 17 ek-SIX|vl<l>

SIP Line Transport| SIP URI| VoIP | T38 Fax SIP Credentials

~

Line Number [17 %
| 1T5P Domain Name 192.168.64.174 ' | [im sarvice =
URI Type SIP ¥ |
Prefix |check 0os |
Mational Prefix 2 ICa|I Routing Method Request LRI v |
Country Code g?\?\:;aégtr:l gﬁrgblziv:riﬁag calls |
International Prefix ‘ Name Priority | System Default v
Send Caller ID P Asserted ID v | Caller ID from From header  []
Association Method |By Source IP address v Send From In Clear O

User-Agent and Server
Headers

Service Busy Response 37486 - Busy Here v

Action on CAC Location Limit | Allow Yoicemail v

[C] REFER Support

Method for Session Refresh | Auto v

Session Timer {seconds) }500

1]/<3

Media Connection Preservation | Disabled v
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5.4.3. SIP Line — Transport Tab
Navigate to the Transport tab and set the following:

e Setthe ITSP Proxy Address to the IP address of the service provider SIP Trunking access
interface provided by Windstream.

e Setthe Layer 4 Protocol to UDP.
e Set Use Network Topology Info to LAN2 as configured in Section 5.2.1.

e Set the Send Port to 5060.

7 SIP Line - Line 17* x-E|X|vl<]|>
SIP Line| Transport S1p LRI volP | 738 Fax|SIP Credentials
ITSP Proxy Address |192.168.64.174

Metwork Configuration

Layer 4 Protocol 1UDP v Send Port E5050 =

Use MNetwork Topology Info ’LAN 2 v

Explict DNSServer(s) | 0 . 0 . 0 . 0 [|[0 .0 .0 . 0 |

Calls Route via Registrar
|

Separate Registrar ,|
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5.4.4. SIP Line — SIP Credentials Tab

SIP Credentials are used to register the SIP Trunk with a service provider that requires SIP Registration.
SIP Credentials are unique per customer and therefore customers must contact the service provider to
obtain the proper registration credentials for their deployment. Windstream used static IP authentication
for the compliance test, therefore the SIP Credentials configuration was not needed. This section is
included in these application notes for reference and completeness.

Select the SIP Credentials tab, and then click the Add button and the New Channel area will appear at
the bottom of the pane. To edit an existing entry, click an entry in the list at the top, and click the Edit...
button. The screen below shows a sample entry being edited.

e Set the User name, Authentication Name, and Contact fields to the registration string provided

by the service provider. This is generally a 10-digit telephone number like 7329624489 as shown
below.

e Inthe Password field, enter the registration password provided by the service provider.
e Inthe Expiry (mins) field, enter the time in minutes until the registration expires.
e Check the Registration required field if Registration is required for the SIP Trunking customer

account.
= SIP Line - Line 17 k- X[ vl<|>
SIP Liné Transport| SIP Uﬁl yoIP ||T38 Fax| SIP Credentials
‘ Index  UserName Authentication Mame  Contact Expiry (mins) ~ Register Add...
|1 7329624489 7329624459 7329624489 60 True
Remove
Edit...

Edit SIP Credentials
User name 329624489
Authentication Name (7329624489 |
Contact 7329624439 ‘
Password [
Expiry (mins) |60 )
Reqistration required
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5.4.5. SIP Line — SIP URI Tab

Select the SIP URI tab to create a SIP URI entry or edit an existing entry. A SIP URI entry matches
each incoming number that Avaya IP Office will accept on this line. Click the Add button and the
New Channel area will appear at the bottom of the pane. For the compliance test, a single SIP URI
entry was created to match any DID number assigned to Avaya IP Office users. The following
screen shows the edit window on a previously configured entry for the compliance test.

e Set Local URI to Use Internal Data. This setting allows calls on this line whose SIP URI
matches the SIP Name set on the SIP tab of any User as shown in Section 5.6.

e Set Contact and Display Name to Use Internal Data. This setting will cause the Contact
and Display Name data for outbound messages to be set from the corresponding fields on the
SIP tab of the individual User as shown in Section 5.66.

e Set PAI to None. This setting directs Avaya IP Office to send the PPI (P-Preferred-Identity)
header for outbound anonymous calls instead of the PAI header (P-Asserted-ldentity). The
PPI header will be populated from the data set in the SIP tab of the call initiating User as
shown in Section 5.66. See Section 5.10 for use of PAI instead of PPI.

e Select the Registration value that was configured in Section 5.4.4, or 0: <None> if the service
provider uses static IP authentication (as was the case with the compliance test).

e Associate this line with an incoming line group by entering line group number in the
Incoming Group field. This line group number will be used in defining incoming call routes
for this line. Similarly, associate the line to an outgoing line group using the Outgoing
Group field. For the compliance test, the incoming and outgoing group 17 was specified.

e Set Max Calls per Channel to the number of simultaneous SIP calls allowed using this SIP

URI pattern.
= SIP Line - Line 17 ek-# I X|vl<]|>
SIP Ling | Transport) SIP URT lolp | T38 Fax| SIP Credentials
Channel  Groups Via Local URI Contact Display Name = PAI Add...
1 17 17 1% M.
Remove
Edit...
Edit Channel
:
Via | 192.168.96.231 ‘
ILocaI URI |Use Internal Data v I
Contact Use Internal Data v
Display Name |Use Internal Data v
IPAI {None v
|Registration |0: <Mone:> v
Incoming Group 17
Qutgoing Group ji7
IMax Calls per Channel |10] < |
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5.4.6.
Select t

Ko

SIP Line — VoIP Tab
he VoIP tab. Set the parameters as shown below.

Set the Codec Selection to Custom.

Choose G.711 ULAW 64K and G.729(a) 8K CS-ACELP from the Unused box and move
these two selections to the Selected box. Use the up and down arrows in the middle to order
these 2 codes. The G.711u and G.729a codecs are supported by Windstream SIP Trunking.
G.711u was configured as the preferred codec for the compliance test as shown below. If fax
is not a supported application in the deployment environment, G.729a should be configured
as the first in the Selected list since Windstream SIP Trunking prefers G.729a for voice calls.
Select G.711 for Fax Transport Support (or None if fax is not a supported application on
this SIP Line).

Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones as out-band RTP events as per RFC2833.

Uncheck the VolP Silence Suppression option box.

Verify that Allow Direct Media Path is disabled (see the Direct Media item in the
observation/limitation list in Section 2.2).

Check the Re-invite Supported option box.

Check the PRACK/100rel Supported option box. This setting enables support by Avaya IP
Office for the PRACK (Provisional Reliable Acknowledgement) message on SIP trunks.

SIP Line - Line 17 - X< ]|

SIP Line | Transport |SIP URI| VoIP T35 Fax| SIP Credentials

ID YolIP Silence Suppression]

[] Allow Direct Media Path

Codec Selection iCustom Vhil [ Re-invite supported]
Unused Selected
(G.711 ALAW 64K L ss | e7n law edk I codec oo
|G.723.1 6K3 MP-MLQ |G.729(a) 8K C5-ACELP [ Prack; 1006l Supported |

Force direct media with phones
£S5 [[] G.711 Fax ECAN

IFax Transport Support | G.711 _V—I

Location ;LCloud v/

Call Initiation Timeout (s) 4 El

IDTMF Support \RFC2833 v I
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5.5. Short Code

Define a short code to route outbound calls to the SIP Line. To create a short code, right-click on
Short Code in the Navigation Pane and select New (not shown). On the Short Code tab in the
Details Pane, configure the parameters as shown below:

e Inthe Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. The 9N; short code, used for the compliance test, will be invoked when the user dials
9 followed by any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N”@192.168.64.174”. This field is used to construct the Request
URI and To headers in the outgoing SIP INVITE message. The value N represents the
number dialed by the user. The IP address following the @ sign is the IP address of the
Windstream SIP Trunking access interface.

e Setthe Line Group Id to the Outgoing Group number defined on the SIP URI tab on the
SIP Line in Section 5.4.5. This short code will use this line group when placing the outbound

calls.
IP Offices 9N;: Dial® k" | X|v|<]|>
# R BOOTP(2) Short Code
+-¢7 Operator (3) -
(=)-%2p Jersey City Code »9N;
[#-%%9 System (1) - 5
© 17 Line (6) Feature _Dlal v
<= Control Unit (2) Telephone Number  |N'@192.168.64.174"
+ -4 Extension {17) :
@ User(18) Line Group 1D |17 v
* 5 Group (1) 7 s
e/ 1 15hort Code (66) Locale United States (US English) v
@ service (0) Force Account Code  []
o, RAS (1)

P Incoming Call Route (15)
£8 wanPort (0}
s Directory (0)
£ Time Profile (0)
@ Firewal Profile (1)
+ [l 1P Route (4)
g Account Code (0)
., License {(64)
W& Tunnel {0)
# §q User Rights (8)
¢ ARS (2)
" RAS Location Request {0}
i Location (0)
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The simple 9N; short code illustrated above does not provide a means of alternate routing if the
configured SIP Line is out of service or temporarily not responding. When alternate routing options
and/or more customized analysis of the dialed digits following the short code are desired, the Automatic
Route Selection (ARS) feature may be used. In the screen below, the short code 8N; is illustrated for
access to ARS. When the Avaya IP Office user dials 8 plus any number N, rather than being directed to a
specific Line Group Id, the call is directed to 50: Main, configurable via ARS. See Section 5.8 for
example ARS route configuration.

Short Code ‘
Code \an;
Feature Dial |

Telephone Number M

Line Group ID ;50: Main v

Locale v |

Force Account Code  []
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5.6. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP Line.
To configure these settings, first navigate to User->Name in the Navigation Pane, where Name is
the name of the user to be modified. In the example below, the name of the user is Tony 9611 at
extension 256. Select the SIP tab in the Details Pane. The SIP Name and Contact are set to one of
the DID numbers assigned by Windstream. The SIP Display Name (Alias) can optionally be
configured with a descriptive text string. The value entered for the Contact field will be used in the
Contact header for outgoing SIP INVITE to the service provider. The value entered for the SIP
Name is used as the user part of the SIP URI in the From header for outgoing SIP trunk calls.

If outbound calls involving this user and a SIP Line should be considered private, then the
Anonymous box may be checked to withhold the user’s information from the network (see item
Blocking CPN for Outbound Calls in the observation/limitation list in Section 2.2).

IP Offices B Tony 9611: 256 ek -® X v <]

= R Boote (22 ) to User | Voicemail | DND | Short Codes | Source Numbers | Telephony | Forwarding | Dial In | Yoice Recording | Button Programming
+-¢7 Operator (3 (

v i i i sIp i
-2y Jersey City | Menu Programming || Mobillty || Group Membership || Announcements | | Personal Directory |

= System (1) SIP Name 5012871493

#-F7 Line (6) —

#-<= Control Unit (2) SIP Display Mame (Alias) | Tony 9611

# -4 Extension (17) —

= & User (18) Contact 5012871493

frg MoUser

§rg RemateManager

| 251 Allan 9630

) 201 Extn201

| 202 Extn202

| 203 Extn203

| 204 Extn204

) 205 Extn20S

| 206 Extn206

| 207 Extn207

| 208 Extn208

| 252 James 1616
e 258 Jim 1120E

e 253 John Softphon
e 259 Juan FlareWin
e 255 RW Flareiin
e 257 Taili 1140E

|
[+ 5§ Group (1)

(8% Short Code (66)

[] anonymous

The following screen shows the similar SIP settings for an analog extension user for fax:

Ko

= Extn208: 208 -9 X|v]|<]|>

User | Woicemail | DND | Short Codes | Source Numbers | Telephony | Forwarding | Dial In || Voice Recording || Button Programming
Menu Programming | Mobility | Group Membership | Announcements | SIP | Personal Directory

SIP Name 5012871492
SIP Display Name (Alias) [Extn208 FAX

Contact 5012871492

[] Anonymous
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5.7. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To create
an incoming call route, right-click Incoming Call Route in the Navigation Pane and select New (not
shown). On the Standard tab in the Details Pane, enter the parameters as shown below:

e Set the Bearer Capacity to Any Voice.
e Setthe Line Group Id to the Incoming Group of the SIP Line defined in Section 5.4.5.
e Set the Incoming Number to the incoming DID number on which this route should match.

IP Offices B 17 5012871493 ek-B I X|vl<l>
#- & BOOTP(2) | Standard | voice Recording | Destinations
[#¢7# Operator (3)
=%y Jersey City — —
[#-%%9 System (1) Bearer Capability Any Yoice v
-1 Line (6) ) : .
<= Control Unit (2) Line Group 1D {17 ¥
(-4 Extension (17) Incoming Number. [s012871493
® & User (18)
[ 5@ Group (1) Incoming Sub Address
(# 8% Short Code (66)
@ Service (0) Incoming CLI |
t ok RAS (Q Locale "United States (US English) v |
=€ Incoming Call Raute (5) S !
@1 Priority 1-Low v |
@0 = =
@0 Tag ,
@ 175012871490 ) =
v
e 17.5012871491 Hold Music Source |System Source L |
0 17 5012871492 Ring Tone Override |None v/
(1] 17 5012571493 e = — =
D 175012871494

On the Destinations tab, select the destination from the pull-down list of the Destination field. In
this example, incoming calls to the DID number 5012871493 on Incoming Group 17 are to be routed
to the user “Tony 9611 at extension 256.

= 17 5012871493 ek -9 X|vl<]|>
Standard | Voice Recording | Destinations
TimeProfile Destination Fallback Extension
14 Default Value 256 Tony 9611 v v |l

The screen below shows calls to 5012871491 are to be routed to IP Office VVoicemail Pro for
message retrieval.

T 17 5012871491 - X|v|<]>
| Standard | Voice Recording .7 Destinations. L
TimeProfile Destination Fallback Extension
> Default Yalue YoiceMail v |J v
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5.8. ARS and Alternate Routing

While detailed coverage of Automatic Route Selection (ARS) is beyond the scope of these Application
Notes, this section includes basic ARS screen illustration and considerations. ARS is shown here mainly
to illustrate alternate routing should the SIP Line be out of service or temporarily not responding.

Optionally, ARS can be used to supplement or replace the simple 9N; short code approach documented
in Section 5.5. With ARS, secondary dial tone can be provided after the access code, time-based routing
criteria can be introduced, and alternate routing can be specified so that a call can re-route automatically
if the primary route or outgoing line group is not available. ARS also facilitates more specific dialed
telephone number matching, enabling immediate routing and alternate treatment for different types of
numbers following the access code. For example, if all local and long distance calls should use the SIP
Line, but service numbers should prefer a different outgoing line group, ARS can be used to distinguish
between the two call patterns.

To add a new ARS route, right-click ARS in the Navigation Pane and select New (not shown). To view
or edit an existing ARS route, expand ARS in the Navigation Pane and select a route name.

The following screen shows an example ARS configuration for the route named 50: Main. The In
Service parameter refers to the ARS form itself, not the Line Groups that may be referenced in the form.
If the In Service box is un-checked, calls are routed to the ARS route name specified in the Out of
Service Route parameter. IP Office short codes may also be defined to allow an ARS route to be
disabled or enabled from a telephone. The configurable provisioning of an Out of Service Route and the
means to manually activate the Out of Service Route can be helpful for scheduled maintenance or other
known service-affecting events for the primary route.

IP Offices Ei Main® ek-E X vi<|>

#- & BOOTP(2) ARS
#-¢7 Operator (3) -
[=-%2y Jersey City ARS Route Id Secondary Dial tone
b %% System (1) ; 5 j S
I+ T4 Line {6) Route Name ‘ SystemTone M|
)<= Control Unit (2) i
4 Extension (17) Dial Delay Time |System Default (4) = Check User Call Barring
| @ User(18) 7
| 5% Group (1)
|- @% Short Code (66)
B service (0)
o, RAS (1) l
@9 Incoming Call Route (15) .
@ ‘WanPort {0} Time Profile —) - OUE OF Hours Route | <MNone> v
= Directory (0) l i
£ Time Profile (0)

2 @ Firewall Profile (1) T
= [l 1P Route (4) | Code Telephone Number Feature Line Group ID
#m Account Code (0) 911 911 Dial Emergency [1]
., License (64) I; N"@192.168.64.174" Dial 17 Remove
@& Tunnel (0)
# § User Rights (8)
¢ ARS (2)
go0: tain
"¢ 51: backup
" RAS Location Request (0} i
5 Location (0) l

L S S S

In Service Out of Service Route S1: backup v

Ry

o)

Edit...

Alternate Route Priority Level |3 v | l

Alternate Route Wait Time 30 4 | ey Alternate Route |51: backup v
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Assuming the primary route is in-service, the number passed from the short code used to access ARS
(e.g., 8N; in Section 5.5) can be further analyzed to direct the call to a specific Line Group ID. Per the
example screen above, if the user dialed 8-911, the call would be directed to Line Group 0 to be sent out
to the local area emergency response center (note that a short code 911 can also be configured to send the
emergency call out when the user simply dials 911). If the user dialed 8 + any other number, the call
would be directed to Line Group 17 as configured in Section 5.4.5. If the primary route cannot be used,
the call can automatically route to the route name specified in the Alternate Route field in the lower
right of the screen (51: Backup). Since alternate routing is considered a privilege not available to all
callers, IP Office can control access to the alternate route by comparing the calling user’s priority,
configured in the User tab of individual users, to the value in the Alternate Route Priority Level field.

5.9. SIP Options

Avaya IP Office sends SIP OPTIONS messages periodically to determine if the SIP connection is
active. By default, Avaya IP Office Release 9.0 sends out OPTIONS every 300 seconds. The rate at
which the messages are sent is determined by the combination of the Binding Refresh Time (in
seconds) set on the Network Topology tab in Section 5.2.1 and the SIP_OPTIONS_PERIOD
parameter (in minutes) that can be set on the Source Number tab of the noUser user. The
OPTIONS period is determined in the following manner:

e To use the default value, set Binding Refresh Time to 0 or 300. OPTIONS will be sent at
the 300 second frequency.

e To establish a period of less than 300 seconds, do not define the SIP_OPTIONS_PERIOD
parameter and set the Binding Refresh Time to a value less than 300 seconds. The
OPTIONS message period will be equal to the Binding Refresh Time setting.

e To establish a period greater than 300 seconds, a SIP_OPTIONS_PERIOD parameter
must be defined. The Binding Refresh Time must be set to a value greater than 300
seconds. The OPTIONS message period will be the smaller of the Binding Refresh Time
and the SIP_OPTIONS_PERIOD settings.

To configure the SIP_OPTIONS_PERIOD parameter, navigate to User = noUser in the
Navigation Pane. Select the Source Numbers tab in the Details Pane. Click the Add button.

#- & BOOTP(2) -
+-¢7 Operator (3)
(=% Jersey City

Menu Programming | Mobility | Group Membership | Announcements | SIP Personal Directory
User | Voicemail | DND | Short Codes | Source Numbers | Telephony | Forwarding | Dial In | Yoice Recording | Button Programming

#- System (1) Source Number
+ 17 Line (6)
# <= Control Unit {2) Remove
[+ -4 Extension (16)
=@ User(18) Edit...
g Molser

f RemoteManager
251 Allan 9630

& 201 Extn201

| 202 Extn202

| 203 Extn203

| 204 Extn204

| 205 Extn20S
206 Extn206

& 207 Extn207

& 203 Extn208

| 252 James 1616
e 258 Jim 1120E
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At the bottom of the Details Pane, the Source Number field will appear. Enter
SIP_OPTIONS_PERIOD=X, where X is the desired value in minutes. Click OK.

Mew Source Number

Source Number |SIP_OPTIONS_PERIOD=6

The SIP_OPTIONS_PERIOD parameter will appear in the list of Source Numbers as shown
below. Click OK at the bottom of the screen (not shown).

ﬁ NoUser: * e -9 | X | v|<]|>

Menu Programming | Mobility | Group Membership | Announcements | SIP Personal Directory

User | Yoicemail | DND | Short Codes? Source Mumbers :Telephony Forwarding || Dial In | Voice Recording || Button Programming |

Source Mumber
|

| SIP_OPTIONS_PERIOD=6 [

Remove

Edit...

For the compliance test, an OPTIONS period of 60 seconds was desired. The Binding Refresh
Time was set to 60 seconds in Section 5.2.1. Thus, there was no need to define
SIP_OPTIONS_PERIOD.
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5.10. Privacy/Anonymous Calls

For outbound calls with privacy (anonymous) enabled, Avaya IP Office will replace the calling party
number in the From and Contact headers of the SIP INVITE message with “anonymous”. Avaya [P
Office can be configured to use the P-Preferred-lIdentity (PPI) or P-Asserted-ldentity (PAI) header to
pass the actual calling party information for authentication and billing. By default, Avaya IP Office
uses PPI for privacy.

To configure Avaya IP Office to use PAI for privacy calls, select NoUser under User in the
Navigation Pane, then select the Source Numbers tab in the Details Pane as shown in the first
screen in Section 5.9. Click the Add button.

At the bottom of the Details Pane, the Source Number field will appear. Enter
SIP_USE_PAI_FOR_PRIVACY. Click OK.

Mew Source Murber
K

Source Number SIP_USE_PAI_FOR_PRIVACY

The SIP_USE_PAI_FOR_PRIVACY parameter will appear in the list of Source Numbers as
shown below. Click OK at the bottom of the screen (not shown).

NoUser: * B - X wl<]|=

Menu Programming | Mobility | Phone Manager Options | Hunt Group Membership | Announcements | SIP Personal Directory

User | Voicemail | DND ShortCodes | Source Mumbers | Telsphony | Forwarding | Dial In || Yoice Recording | Butkon Programming

SIP_IUSE_PAL_FOR_PRIVACZY
Remove

Note that Windstream SIP Trunking does not support anonymous calls from the enterprise. See item
Blocking CPN for Outbound Calls in the observation/limitation list in Section 2.2 for details and
workaround.

AMC; Reviewed: Solution & Interoperability Test Lab Application Notes 33 of 38
SPOC 6/17/2014 ©2014 Avaya Inc. All Rights Reserved. WS-SipTrkIPO9



5.11. Save Configuration
Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following Save Configuration screen will appear, with either Merge or Immediate selected,
based on the nature of the configuration changes made since the last save. Note that clicking OK

may cause a service disruption. Click OK to proceed.

Save Configuration

IP Office Settings
Jersey City
Configuration Reboot Mode
(%) Merge
() Immediate
() When Free
) Timed

Reboot Time

Call Barring

[ |

[ QK J[ Cancel ][ Help ]

6. Windstream SIP Trunking Configuration

Windstream is responsible for the configuration of its SIP Trunking Service. The customer will need
to provide the IP address used to reach the Avaya IP Office at the enterprise site (i.e., the IP address
of the LANZ port on the Avaya SBCE). Windstream will provide the customer the necessary
information to configure the Avaya IP Office including:

Network edge IP addresses of the Windstream SIP Trunking Service.

[ ]
e Transport and port for the Windstream SIP Trunking connection to the enterprise site.
e DID numbers to assign to users at the enterprise.
e Supported codecs and their preference order.
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7. Verification Steps

This section provides verification steps that may be performed in the field to verify that the solution
is configured properly

7.1. System Status
Use the Avaya IP Office System Status application to check the SIP Line channels state and alarms:

e Launch the application from Start - Programs - IP Office - System Status on the
Avaya IP Office Manager PC. Select the SIP Line under Trunks from the left pane. In the
Status tab in the right pane, verify the Current State is Idle for channels not taken by active

calls; the state should be Connected for the channels engaged in active calls.

K System
B & Alarms (1)
K Extensions (12)

Help Snapshot LogOff Exit About

Status | Utilization Summary Alarms

Avaya IP Office System Status - Jersey City (10.32.128.30) - IP500 ¥2 9.0.1.0 build 845

IP Office System Status

EEX

SIP Trunk Summary

B Trunks (6)
Lines:1-4 Peer Domain Mame: 192.168.64.174
’_ nen Resolved Address: 192.168.64.174
Ac‘:“:ec:.‘:g Line Number: 17
I Resources MNumber of Administered Channels: 10
K Voicemail Number of Channels in Use: 2
KX IP Hetworking Administered Compression: G711 Mu, G729 A
Locations Silence Suppression: OFF
Layer 4 Protocol: UDP
SIP Trunk Channel Licenses: Unlimited . 1%
SIP Trunk Channel Licenses in Use: 2

SIP Device Features:

Time in R.. Codec Connection  C. Other Party on Call Direction R. Re e Transmit Transmit
St State Type of Ca Jit Jitter Packet... |
Connected | 00:02:09 |...

1 G711 Mu | RTPRelay |...|Extn 256, Tony 9611 Incoming
2 0 Connected | 00:01:51 |...| G711 Mu | RTPRelay | [Extn 258, Jim 1120E Outgoing
3 Idle 1 day 20...
4 Idle 1 day 20...
S Idle 1 day 20...
6 Idle 1 day 20...
7 Idle 1 day 20...
8 Idle 1 day 20...
9 Idle 1 day 20...
10 Idle 1 day 20...
Trace [ Trace All ] [ Pause ] [ Ping ] Call Details [ Print... ] [ Save As... ]

e Select the Alarms tab and verify that no alarms are active on the SIP Line.

Status  Utilization Summary Alarms

Alarms for Line: 17 SIP 192.168.64.174

Last Date OF Error Occurrences

Etror Description

350f 38
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7.2. Monitor

The Monitor application can be used to monitor and troubleshoot Avaya IP Office. Monitor can be
accessed from Start = Programs > IP Office = Monitor on the Avaya IP Office Manager PC.
The application allows monitored information to be customized. To customize, select Filters >
Trace Options... as shown below:

£ Avaya IP Office SysMonitor - [STOPPED] Monitoring 10.32.128.30 ; Log Settings - C:\Documents and Settingsk...\sip... Q@@
File Edit View BEEEN Status Help

2R »E |Trace Options ... Cbrl+T | &*
I"i Send To Syslog

The following screen shows the SIP tab of trace options. In this example, Standard SIP Events and
the SIP Rx and SIP Tx boxes are checked.

All Settings @

T | YPN | WAN | SCN | Jade |
ATM | cal | DTE | EConf | FrameRelay | GOD | H323 | Interface |
ISDN | Key/Lamp | Directory | Media | PPP | B2 | Routing | Services SIP |System|

Events

WV Sip {m [~ STUN [~ SIP Dect
Packets

[~ SIP Reg/Opt Rx [~ SIP Misc Rz

[~ SIP Reg/Opt Tx [ SIP Misc Tx

[~ SIPCalR [~ Cm Naotify Rz

[~ Cm Notify Tx
v SipRx IP Filter (nnh.nnn.nhn.nnn)
V SipTx [
Default AIII Clear All | Tab CIearAHl Tab SelAII‘ oK Cancel
Save File I Load File l Load Partial File | Select File |
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8. Conclusion

The Windstream SIP Trunking service passed compliance testing. These Application Notes describe
the procedures required to configure the connectivity between Avaya IP Office and Windstream SIP
Trunking as shown in Figure 1. Test results and observations are noted in Section 2.2.

9. Additional References

[1] IP Office Documentation Library, Release 9.0, Documentation number 15-604278 Issue 1,
September 2013

[2] IP Office 9.0 Product Description, Documentation number 15-601041 Issue 27.02.0, January
2014.

[3] Avaya IP Office 9.0 Installing IP500/IP500 V2, Document number15-601042 Issue 28j, January
2014.

[4] Avaya IP Office 9.0 Administering Voicemail Pro, Document number15-601063 Issue 9.01.0,
September 2013.

[5] Avaya IP Office Manager Release 9.0, Document number15-601011 Issue 9.02.0, January 2014.

[6] Avaya IP Office 9.0 Using System Status, Document number15-601758 Issue 09c, August 2013.

[7] Avaya IP Office 9.0 Using IP Office System Monitor, Document Number 15-601019, Issue 05c,
August 2013.

[8] Avaya IP Office 9.0 H.323 Telephone Installation, Document Number 15-601046, Issue 18b,
August 2013.

[9] Avaya IP Office 9.0 SIP Extension Installation, Issue 3c, August 2013.

Additional IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/.

Product documentation for the Windstream SIP Trunking is available from Windstream. See Section
2.3 on how to contact Windstream.
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full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.
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